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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard,
flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device
and the AC adapter comply with the user-accessible surface temperature limits defined by
the International Standard for Safety of Information Technology Equipment (IEC 60950).

iii
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1 Product description

Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Product Name HP Pavilion g7 Notebook PC √ √

Processors AMD A8-3520M 2.50 GHz processor
(1.6 GHz Front-Side Bus (FSB), 1333 MHz/
4.0 MB L2 cache, quad core, 35 W)

√  

 AMD A6-3420M 2.40 GHz processor
(1.5 GHz FSB, 1333 MHz/4.0 MB L2 cache,
quad core, 35 W)

√  

 AMD A4-3320M 2.60 GHz processor
(2.0 GHz FSB, 1333 MHz/2.0 MB L2 cache,
dual core, 35 W)

√  

 AMD A4-3305M 2.50 GHz processor
(1.9 GHz FSB, 1333 MHz/2.0 MB L2 cache,
dual core, 35 W)

√  

 AMD E2-3000M 2.40 GHz processor
(1.8 GHz FSB, 1333 MHz/1.0 MB L2 cache,
dual core, 35 W)

√  

 Intel® CoreTM i7-2640M 2.80 GHz (SC turbo
up to 3.50 GHz), Pin Grid Array (PGA)
processor (4.0 MB L3 cache, dual core,
35 W)

 √

 Intel Core i5-2540M 2.60 GHz (SC turbo up
to 3.30 GHz), PGA processor (3.0 MB
L3 cache, dual core, 35 W)

 √

 Intel Core i5-2520M 2.50 GHz (SC turbo up
to 3.20 GHz), PGA processor (3.0 MB
L3 cache, dual core, 35 W)

 √

 Intel Core i5-2450M 2.50 GHz (SC turbo up
to 3.10 GHz), PGA processor (3.0 MB L3
cache, dual core, 35 W)

 √

 Intel Core i5-2430M 2.40 GHz (SC turbo up
to 3.00 GHz), PGA processor (3.0 MB L3
cache, dual core, 35 W)

 √

 Intel Core i3-2370M TJ85 2.40 GHz, PGA
processor (3.0 MB L3 cache, dual core,
35 W)

 √

 Intel Core i3-2350M TJ85 2.30 GHz, PGA
processor (3.0 MB L3 cache, dual core,
35 W)

 √

 Intel Core i3-2330M TJ85 2.20 GHz, PGA
processor (3.0 MB L3 cache, dual core,
35 W)

 √

1
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Intel Pentium® B970 TJ85 2.30 GHz, PGA
processor (2.0 MB cache, dual core 35 W)

 √

 Intel Pentium B960 TJ85 2.20 GHz, PGA
processor (2.0 MB L3 cache, dual core 35 W)

 √

 Intel Pentium B950 TJ85 2.10 GHz, PGA
processor (2.0 MB L3 cache, dual core 35 W)

 √

Chipset AMD A60M Fusion Controller Hub (FCH) √  

 Intel HM65 Express Chipset  √

Graphics Internal graphics:

● AMD Radeon HD 6620G graphics
supporting HD decode, DX11, and
HDMI on computer models equipped
with an AMD A8-3520M processor

● AMD Radeon HD 6520G graphics
supporting HD decode, DX11, and
HDMI on computer models equipped
with an AMD A6-3420M processor

● AMD Radeon HD 6480G graphics
supporting HD decode, DX11, and
HDMI on computer models equipped
with an AMD A4-3305M or A4-3320M
processor

● AMD Radeon HD 6380G graphics
supporting HD decode, DX11 and HDMI
on computer models equipped with an
AMD E2-3000M processor

√  

 Internal graphics:

● Intel HD Graphics 3000, on computer
models equipped with an Intel Core i7,
Intel Core i5, or Intel Core i3 processor;
supports DX10

● Intel HD Graphics, on computer models
equipped with an Intel Pentium
processor; supports DX10

 √

 Switchable discrete graphics:

● AMD Radeon HD 7450M with 1024 MB
of dedicated video memory (128 MB ×
16 DDR3 @ 900 MHz × 4 PCs), 64 bit
S3 package, muxless switchable,
supports HD Decode, DX11, HDMI. and
Bus Alive/Chip Off (BACO)

● AMD Radeon HD 7450M with 512 MB of
dedicated video memory (64 MB ×
16 DDR3 @ 900 MHz × 4 PCs), 64 bit
S3 package, muxless switchable,
supports HD Decode, DX11, HDMI, and
BACO

√
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Switchable discrete graphics:

● ATI Mobility Radeon HD 7450M with
1024 MB of discrete video memory
(128 MB × 16 DDR3 @ 900 MHz ×
4 PCs), 64 bit S3 package,
muxless switchable, supports HD
Decode, DX11, HDMI, and BACO

● ATI Mobility Radeon HD 7450M with
512 MB of discrete video memory
(64 MB × 16 DDR3 @ 900 MHz ×
4 PCs), 64 bit S3 package,
muxless switchable, supports HD
Decode, DX11, HDMI, and BACO

√

 Dual graphics:

● AMD Radeon HD 6620G+7450M Dual
Graphics for computer models equipped
with an AMD Radeon HD 7450M
graphics card and an AMD A8-3520M
processor

● AMD Radeon HD 6520G+7450M Dual
Graphics for computer models equipped
with an AMD Radeon HD 7450M
graphics card and an AMD A6-3420M
processor

● AMD Radeon HD 6480G+7450M Dual
Graphics for computer models equipped
with an AMD Radeon HD 7450M
graphics card and an AMD A4-3320M or
AMD A4-3305 processor

√

Panel 43.9 cm (17.3 in), high-definition+ (HD+),
LED, SVA BrightView (1600×900) display;
typical brightness: 200 cd/m2

All display assemblies include 2 wireless
local area network (WLAN) antenna cables

Supports 16:9 wide aspect ratio

√ √

Memory 2 customer-accessible/upgradable memory
module slots

√ √

 Supports dual-channel memory √ √

 Supports up to 8192 MB of system RAM √ √

 DDR3/1333 MHz (DDR3-1600 (1 GB / 2 GB /
4 GB / 8 GB) memory modules supported as
an alternative source for DDR3-1333 )

√ √

3
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Supports:

● Supports 8192 MB total system memory
(4096×2)

● 6144 MB total system memory (4096×1
+ 2048×1)

● 5120 MB total system memory (4096×1
+ 1024×2)

● 4096 MB total system memory (4096×1
or 2048×2)

● 2048 MB total system memory (2048×1)

√ √

Hard drives Supports 6.35 cm (2.5 in) hard drives in
9.5 mm (.37 in), and 7.0 mm (.28
in) thicknesses

√ √

 Customer-accessible √ √

 Serial ATA √ √

 Supports the following configurations:

● 750 GB, 5400 rpm (9.5 mm)

● 640 GB, 5400 rpm (9.5 mm)

● 500 GB, 7200 rpm and 5400 rpm (9.5
mm)

● 320 GB, 7200 rpm and 5400 rpm (both
7.0 mm and 9.5 mm)

● 160 GB solid-state drive (SSD), 6.35 cm
(2.5 in)

√ √

Optical drive Fixed √ √

 Serial ATA √ √

 12.7 mm tray load √ √

 Blu-ray Disc (BD) ROM DVD±R/RW Super
Multi Double-Layer Drive

√ √

 DVD±RW and CD-RW Super Multi Double-
Layer Combo Drive

√ √

Audio and video Single digital microphone √ √

 HD audio √ √

 HP-branded Altec/Lansing speakers √ √

 Supports Microsoft® Premium requirements √ √

 HP VGA webcam (fixed, no tilt with activity
LED, 640×480 by 24 frames per second

√ √

Ethernet Integrated 10/100 network
interface card (NIC)

√ √

4 Chapter 1   Product description
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Wireless Integrated wireless local area network
(WLAN) options by way of wireless module

√ √

 Two WLAN antennas built into
display assembly

√ √

 Support for the following WLAN formats:

● Atheros 9485GN 802.11b/g/n 1×1 WiFi
and 3012 Bluetooth 4.0 Combo Adapter
(select models with Intel processors)

● Broadcom 4313 802.11b/g/n 1×1 WiFi
and 2070 Bluetooth 2.1+EDR Combo
adapter (BT3.0+HS ready) (select
models with AMD processors)

● Ralink 5390GN 802.11b/g/n 1×1
WiFi Adapter, Sound Blaster half-mini
card (select models with AMD
processors)

● Realtek 8188GN 802.11b/g/n 1x1 WiFi
Adapter, Sound Blaster half-mini card
(select models with Intel processors)

√ √

 Support for the following WLAN formats:

● Intel Centrino Wireless-N 1030
WLAN module, 802.11b/g/n and
Bluetooth Combo Adapter

 √

External media
card

HP Multi-Format Digital Media Reader
supports the following digital card formats:

● Secure Digital (SD) Memory Card

● Secure Digital High Capacity (SDHC)
Memory Card

● Secure Digital Extended Capacity
(SDXC) Memory Card

● MultiMediaCard (MMC)

√ √

5
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Ports ● Smart-Pin AC power adapter

● Audio-in (mono microphone)

● Audio-out (stereo headphone)

● HDMI version 1.4 supporting up to
1080p, 1920 ×1200 @ 60Hz and 1920
×1200 @ 60Hz in DVI mode

● RJ-45 (Ethernet, includes link and
activity lights)

● USB 2.0 (3 ports)

● VGA (Dsub 15 pin) supporting:

◦ 2048×1536 external resolution @
75 Hz (on computer models
equipped with an Intel processor)

◦ 1920×1600 external resolution @
60 Hz (on computer models
equipped with an AMD processor)

◦ Hot plug and unplug and auto-
detection for correct output to wide-
aspect vs. standard aspect video

√ √

Keyboard/pointing
devices

Full-size textured pocket keyboard with full
numeric keypad

√ √

 TouchPad with multi-touch gestures, 2-finger
scrolling, and pinch-zoom enabled

√ √

 Taps enabled by default √ √

Power
requirements

90 W AC adapter with localized cable plug
support (3-wire plug with ground pin,
supports 3-pin DC connector), for use only
with computer models equipped with a
graphics subsystem with discrete video
memory

65 W AC adapter with localized cable plug
support (3-wire plug with ground pin,
supports 3-pin DC connector), for use only
with computer models equipped with a
graphics subsystem with Uniform Memory
Access (UMA) video memory

√ √

 Support for the following batteries:

● 6-cell, 55 Whr, 2.55 Ah Li-ion battery for
use with select computer models only

● 6-cell, 47 Whr, 2.20 Ah Li-ion battery

√ √

Security Security cable slot √ √

6 Chapter 1   Product description
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Operating system Preinstalled:

● Microsoft Windows® 7 Home Basic 64
bit

● Windows 7 Home Premium 64 bit

● FreeDOS

√ √

 Preinstalled:

● Windows 7 Home Professional 64 bit

 √

Serviceability End-user replaceable parts:

● AC adapter

● Battery

● Hard drive or SSD

● Memory modules (2)

● Optical drive

● WLAN module

√ √

7
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2 External component identification

Top

Button

Component  Description

Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to initiate
Sleep.

● When the computer is in the Sleep state, press the button
briefly to exit Sleep.

● When the computer is in Hibernation, press the button briefly to
exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

To learn more about your power settings, select Start > Control
Panel > System and Security > Power Options, or refer to the HP
Notebook Reference Guide.

8 Chapter 2   External component identification
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Keys

Item  Component Description

(1)  esc key Displays system information when pressed in combination with
the fn key.

(2)  Action keys Execute frequently used system functions.

(3)  fn key Displays system information when pressed in combination with
the esc key.

(4) Windows logo key Displays the Windows Start menu.

(5) QuickWeb key ● When the computer is off or in Hibernation mode, press the
button to open HP QuickWeb.

● When the computer is in Windows press the button to open
the default Web browser.

● When the computer is in HP QuickWeb, press the button to
open the default Web browser.

(6) Windows applications
key

Displays a shortcut menu for items beneath the pointer.

(7)  Integrated numeric
keypad

Can be used like an external numeric keypad.

Top 9
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Lights

Item Component Description

(1) TouchPad light ● Amber: the TouchPad is off.

● Off: the TouchPad is on.

(2) Caps lock light ● White: Caps lock is on.

● Off: Caps lock is off.

(3) Power light ● White: the computer is on.

● Blinking white: the computer is in the Sleep state.

● Off: the computer is off or in Hibernation.

(4) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(5) Num lock light ● White: The numeric functions on the integrated
numeric keypad are active.

● Off: The navigational functions on the integrated
numeric keypad are active.

10 Chapter 2   External component identification
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TouchPad

Item Component Description

(1) TouchPad light ● Amber: the TouchPad is off.

● On: the TouchPad is on.

(2) TouchPad on/off button Turns the TouchPad on and off. Quickly double-tap
the TouchPad on/off button to turn the TouchPad on
and off.

(3) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(4) Left TouchPad button Functions like the left button on an external mouse.

(5) Right TouchPad button Functions like the right button on an external mouse.

Top 11
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Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs.

(2) Webcam light On: The webcam is in use.

(3) Webcam Records video and captures still photographs. To use
the webcam, select Start > All Programs > CyberLink
YouCam.

(4) Internal microphone Records sound.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Front

Component Description

Speakers (2) Produce sound.

12 Chapter 2   External component identification
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Left side

Item  Component Description

(1) External monitor port Connects an external VGA monitor or projector.

(2)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal fan to
cycle on and off during routine operation.

(3) RJ-45 (network) jack Connects a network cable.

(4) HDMI port Connects an optional video or audio device, such as a high-definition
television, or any compatible digital or audio component.

(5) USB ports (2) Connect optional USB devices.

(6) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(7) Audio-out (headphone) jacks
(2)

Produce sound when connected to optional powered stereo speakers,
headphones, ear buds, a headset, or television audio.

WARNING! To reduce the risk of personal injury, adjust the volume
before putting on headphones, earbuds, or a headset. For additional
safety information, refer to the Regulatory, Safety and
Environmental Notices.

(8)  Digital Media Slot Supports the following digital card formats:

● Secure Digital (SD) Memory Card

● Secure Digital High Capacity (SDHC) Memory Card

● Secure Digital Extended Capacity (SDXC) Memory Card

● MultiMediaCard

Left side 13
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Item  Component Description

(9) Drive light Blinking white: the hard drive is being accessed.

(10) Power light ● White: The computer is on.

● Blinking white: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

Right side

Item  Component Description

(1)  Optical drive Reads and writes to an optical disc.

(2)  Optical drive light Blinking: The optical drive is being accessed.

(3)  Optical drive eject button Opens the optical drive.

(4) USB port Connects an optional USB device.

(5)  AC adapter light ● White: The computer is connected to external power and the battery
is fully charged.

● Blinking white: The battery has reached a low battery level.

● Amber: A battery is charging.

(6) Power connector Connects an AC adapter.

(7) Security cable slot Connects an optional security cable.

NOTE: The security cable is designed to act as a deterrent, but it may
not prevent the computer from being mishandled or stolen.

14 Chapter 2   External component identification
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Bottom

Item  Component Description

(1)  Battery bay Holds the battery.

(2) Battery release latch Releases the battery from the battery bay.

(3)  Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(4) Hard drive bay Holds the hard drive, the WLAN module, and the memory
module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

Bottom 15
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item Description Function

(1) Product name This is the model name for the computer.

(2) Serial number This alphanumeric identifier is unique to each
product.

(3) Product number This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.
The product number helps a service technician
determine what components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model number This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.

16 Chapter 3   Illustrated parts catalog
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Computer major components
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Item Component Spare part number

(1) 43.9 mm (17.3 in), high definition (HD), light-emitting diode (LED), BrightView display assembly (includes
webcam, two microphones, and wireless antenna transceivers and cables)

 Butter gold 640223-001

 Charcoal gray 640226-001

 Pewter 640227-001

 NOTE: For more display assembly spare part information, see Display assembly subcomponents on page 23.

(2) Keyboard, black (includes keyboard cable):

 For use in Belgium 640208-A41

 For use in Bulgaria (for use only with computer models equipped with an
Intel processor)

640208-261

 For use in Canada 640208-121

 For use in the Czech Republic (for use only with computer models equipped with an
AMD processor)

640208-221

 For use in Denmark, Finland, and Norway 640208-DH1

 For use in France 640208-051

 For use in Germany 640208-041

 For use in Greece 640208-DJ1

 For use in Hungary 640208-211

 For use internationally 640208-B31

 For use in Israel 640208-BB1

 For use in Italy 640208-061

 For use in Portugal 640208-131

 For use in Russia 640208-251

 For use in Saudi Arabia 640208-171

 For use in Slovenia 640208-BA1

 For use in Spain 640208-071

 For use in Switzerland 640208-BG1

 For use in Turkey 640208-141

 For use in the United Kingdom 640208-031

 For use in the United States 640208-001

(3) Top cover (includes TouchPad and TouchPad cable):

 Butter gold 641401-001

 Charcoal gray 641404-001

 Pewter 641405-001

(4) Power button board (includes cable) 640212-001

18 Chapter 3   Illustrated parts catalog
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Item Component Spare part number

(5) TouchPad LED board (includes cable) 640213-001

(6) TouchPad button board (includes cable) 640214-001

 Cable Kit, includes: 640206-001

(7a) TouchPad cable

(7b) Optical drive cable

(7c) Hard drive connector cable

 NOTE: See Cable Kit on page 22 for more Cable Kit spare part information.

(8) Speaker Kit (includes left and right speakers and cable) 641396-001

(9) USB board (includes cable) 640211-001

(10) Power connector cable 641394-001

(11) System board (includes replacement thermal material):

 AMD processor:

 For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with 1024 MB of discrete video memory, supports BACO

649950-001

 For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with 512 MB of discrete video memory, supports BACO

649949-001

 For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with UMA video memory

649948-001

 Intel processor:

 For use only with computer models equipped with the Intel HM65 chipset and a
graphics subsystem with 1024 MB of discrete video memory and supports BACO

650199-001

 For use only with computer models equipped with the Intel HM65 chipset and a
graphics subsystem with 512 MB of discrete video memory and supports BACO

650198-001

 For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with UMA video memory

636373-001

 Thermal Material Kit (includes replacement thermal paste and pads) 634433-001

(12) Processor (includes replacement thermal material)

 AMD A8-3520M 2.50 GHz processor (1.6 GHz FSB, 4.0 MB L2 cache, quad core,
35 W)

669690-001

 AMD A6-3420M 2.40 GHz processor (1.5 GHz FSB, 4.0 MB L2 cache, quad core,
35 W)

669688-001

 AMD A4-3320M 2.60 GHz processor (2.0 GHz FSB, 2.0 MB L2 cache, dual core,
35 W)

669686-001

 AMD A4-3305M 2.50 GHz processor (1.9 GHz FSB, 2.0 MB L2 cache, dual core,
35 W)

672093-001

 AMD E2-3000M 2.40 GHz processor (1.8 GHz FSB, 1.0 MB L2 cache, dual core,
35 W)

677628-001

 Intel Core i7-2640M 2.80 GHz (SC turbo up to 3.50 GHz), PGA processor (4.0
MB L3 cache, dual core, 35 W)

666173-001
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Item Component Spare part number

 Intel Core i5-2540M 2.60 GHz (SC turbo up to 3.30 GHz), PGA processor (3.0 MB
L3 cache, dual core, 35 W)

631255-001

 Intel Core i5-2520M 2.50 GHz (SC turbo up to 3.20 GHz), PGA processor (3.0 MB
L3 cache, dual core, 35 W)

631253-001

 Intel Core i5-2450M 2.50 GHz (SC turbo up to 3.10 GHz), PGA processor (3.0 MB
L3 cache, dual core, 35 W)

676359-001

 Intel Core i5-2430M 2.40 GHz (SC turbo up to 3.00 GHz), PGA processor (3.0 MB L3
cache, dual core, 35 W)

653341-001

 Intel Core i3-2370M TJ85, 2.40 GHz, PGA processor (3.0 MB L3 cache, dual core,
35 W)

677152-001

 Intel Core i3-2350M TJ85, 2.30 GHz, PGA processor (3.0 MB L3 cache, dual core,
35 W)

653340-001

 Intel Core i3-2330M TJ85, 2.20 GHz, PGA processor (3.0 MB L3 cache, dual core,
35 W)

653339-001

 Intel Pentium B970 TJ85 2.30 GHz, PGA processor (2.0 MB L3 cache, dual core,
35 W)

676785-001

 Intel Pentium B960 TJ85 2.20 GHz, PGA, processor (2.0 MB L3 cache, dual core,
35 W)

664662-001

 Intel Pentium B950 TJ85 2.10 GHz, PGA, processor (2.0 MB L3 cache, dual core
35 W)

653338-001

(13) Fan (includes replacement thermal material) 639460-001

(14) Heat sink (includes replacement thermal material)

 AMD processor:

 For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with discrete video memory

649953-001

 For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with UMA video memory

649954-001

 Intel processor:

 For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with discrete video memory

641141-001

 For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with UMA video memory

641140-001

(15) LED board (includes cable) 640215-001

(16) Base enclosure (includes battery release latch, heat sink, replacement
thermal material, and 4 rubber feet)

640203-001

 Rubber Feet Kit (not illustrated, includes 4 rubber feet) 639455-001

(17) Battery:

 6-cell, 55 Whr, 2.55 Ah Li-ion battery, for use with select computer models only 593554-001

 6-cell, 47 Whr, 2.20 Ah Li-ion battery 593553-001

(18) RTC battery (includes cable and double-sided tape) 637193-001
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Item Component Spare part number

(19) Hard drive SATA, does not include hard drive connector cable, isolators, or shield):

 For use with all computer models:

 750 GB, 5400 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 644351-001

 640 GB, 5400 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 637312-001

 500 GB, 7200 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 644685-001

 320 GB, 7200 rpm, 7.0 mm (0.28 in) × 6.35 cm (2.50 in) 645089-001

 160 GB SSD, 6.35 cm (2.50 in) 682589-001

 Hard Drive Hardware Kit (not illustrated, includes front and rear isolators and shield) 639444-001

(20) Memory modules (2, DDR3, 10600, 1333 MHz):

 4 GB 621569-001

 2 GB 621565-001

(21) Optical drive (includes bezel and bracket):

 BD ROM DVD±R/RW Super Multi Double-Layer Drive 659878-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 659877-001

(22) WLAN module:

 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter, for
use with computer models equipped with an AMD processor or select models
equipped with an Intel processor

655795-001

 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter,
for use with computer models equipped with an Intel processor or select models
equipped with an AMD processor

657325-001

 Intel Centrino Advanced-N 6230, for use only with computer models equipped with
an Intel processor

631956-001

 Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter, for use with computer models
equipped with an Intel processor or select models equipped with an AMD processor

630703-001

 Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter, for use with computer models
equipped with an AMD processor or select models equipped with an Intel processor

640926-001

(23) Service door (includes 2 captive screws, secured by C-clips) — available in the Plastics Kit, spare part number
640216-001)
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 640206-001

(1) TouchPad cable

(2) Hard drive connector cable

(3) Optical drive cable
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel 640204-001

(2) Display hinge covers (2) 643698-001

(3) Webcam/microphone module 637197-001

(4) 43.9 cm (17.3 in) HD, LED, BrightView display panel 641395-001

(5) Display Hinge Kit (includes left and right display hinges and brackets) 640207-001

(6) Display Cable Kit (includes display panel cable and webcam/microphone
module cable)

640205-001

(7) Antenna Kit (includes left and right wireless antenna cables and transceivers) 640192-001

(8) Display enclosure:
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Item Component Spare part number

 Butter gold 640197-001

 Charcoal gray 640200-001

 Pewter 640201-001

 Display Screw Kit (not illustrated) 640218-001
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Mass storage devices

Item Component Spare part number

(1) Hard drive (7.0 mm (2.5 in), SATA, does not include hard drive connector cable, isolators, or shield):

 For use with all computer models:

 750 GB, 5400 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 644351-001

 640 GB, 5400 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 637312-001

 500 GB, 7200 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 644685-001

 320 GB, 7200 rpm, 7.0 mm (0.28 in) × 6.35 cm (2.50 in) 645089-001

 160 GB SSD, 6.35 cm (2.50 in) 682589-001

 Hard Drive Hardware Kit, includes: 639444-001

(2a) Hard drive front isolator

(2b) Hard drive rear isolator

(2c) Hard drive shield

(3) Optical drive (includes bezel and bracket):

 BD ROM DVD±R/RW Super Multi Double-Layer Drive 659878-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 659877-001
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Miscellaneous parts

Component Spare part number

HP Smart AC adapter

90 W PFC RC V HP Smart AC adapter, for use only with computer models equipped with a
graphics subsystem with discrete video memory

609940-001

65 W RC V HP Smart AC adapter, for use only with computer models equipped with a graphics
subsystem with UMA video memory

609939-001

Power cord (3-pin, black, 1.83-m):

For use in Denmark 490371-081

For use in Europe 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in North America 490371-001

For use in South Africa 490371-AR1

For use in Switzerland 490371-111

For use in the United Kingdom and Singapore 490371-031

Screw Kit 640217-001

Sequential part number listing

Spare part number Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-021 Power cord for in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Italy (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

593553-001 6-cell, 47 Whr, 2.20 Ah Li-ion battery

593554-001 6-cell, 55 Whr, 2.55 Ah Li-ion battery, for use with select computer models only 

609939-001 65 W RC V HP Smart AC adapter for use only with computer models equipped with a graphics
subsystem with UMA video memory 

609940-001 90 W PFC RC V HP Smart AC adapter for use only with computer models equipped with a
graphics subsystem with discrete video memory 

621565-001 2 GB memory module (DDR3, 10600, 1333 MHz)
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Spare part number Description

621569-001 4 GB memory module (DDR3, 10600, 1333 MHz)

630703-001 Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter for use only on computer models equipped with
an Intel processor or select models equipped with an AMD processor

631253-001 Intel i5-2520M 2.50 GHz (SC turbo up to 3.20 GHz) processor (3.0 MB L3 cache, dual core,
35 W; includes replacement thermal material)

631255-001 Intel i5-2540M 2.60 GHz (SC turbo up to 3.30 GHz) processor (3.0 MB L3 cache, dual core,
35 W; includes replacement thermal material)

631956-001 Intel Centrino Advanced-N 6230 WLAN module for use only on computer models equipped with
an Intel processor

634433-001 Thermal Material Kit (includes replacement thermal paste and pads)

636373-001 System board for use only with computer models equipped with an Intel processor, HM65
chipset, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

637193-001 RTC battery (includes cable and double-sided tape)

637197-001 Webcam/microphone module

637312-001 640 GB, 5400 rpm hard drive, 9.5 mm (0.37 in) × 6.35 cm (2.50 in), SATA, does not include
isolators or shield)

639444-001 Hard Drive Hardware Kit (includes front and rear isolators and shield)

639455-001 Rubber Feet Kit (includes 4 rubber feet)

639460-001 Fan (includes replacement thermal material)

640192-001 Antenna Kit (includes left and right wireless antenna cables and transceivers)

640197-001 Display enclosure, butter gold

640200-001 Display enclosure, charcoal gray

640201-001 Display enclosure, pewter

640203-001 Base enclosure (includes battery release latch, heat sink, replacement thermal material, and 4
rubber feet)

640204-001 Display bezel

640205-001 Display Cable Kit (includes display panel cable and webcam/microphone module cable)

640206-001 Cable Kit (includes hard drive connector cable, optical drive cable, and TouchPad cable)

NOTE: See Cable Kit on page 22 for more Cable Kit spare part information.

640207-001 Display Hinge Kit (includes left and right display hinges and brackets)

640208-001 Keyboard, black, for use in the United States (includes keyboard cable)

640208-031 Keyboard, black, for use in the United Kingdom and Singapore (includes keyboard cable)

640208-041 Keyboard, black, for use in Germany (includes keyboard cable)

640208-051 Keyboard, black, for use in France (includes keyboard cable)

640208-061 Keyboard, black, for use in Italy (includes keyboard cable)

640208-071 Keyboard, black, for use in Spain (includes keyboard cable)

640208-121 Keyboard, black, for use in Canada (includes keyboard cable)
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Spare part number Description

640208-131 Keyboard, black, for use in Portugal (includes keyboard cable)

640208-141 Keyboard, black, for use in Turkey (includes keyboard cable)

640208-171 Keyboard, black, for use in Saudi Arabia (includes keyboard cable)

640208-211 Keyboard, black, for use in Hungary (includes keyboard cable)

640208-221 Keyboard, black, for use in the Czech Republic, for use only with computer models equipped
with an AMD processor (includes keyboard cable)

640208-251 Keyboard, black, for use in Russia (includes keyboard cable)

640208-261 Keyboard, black, for use in Bulgaria (for use only with computer models equipped with an
Intel processor; includes keyboard cable)

640208-A41 Keyboard, black, for use in Belgium (includes keyboard cable)

640208-B31 Keyboard, black, for use internationally (includes keyboard cable)

640208-BA1 Keyboard, black, for use in Slovenia (includes keyboard cable)

640208-BB1 Keyboard, black, for use in Israel (includes keyboard cable)

640208-BG1 Keyboard, black, for use in Switzerland (includes keyboard cable)

640208-DH1 Keyboard, black, for use in Denmark, Finland, and Norway (includes keyboard cable)

640208-DJ1 Keyboard, black, for use in Greece (includes keyboard cable)

640211-001 USB board (includes cable)

640212-001 Power button board (includes cable)

640213-001 TouchPad LED board (includes cable)

640214-001 TouchPad button board (includes cable)

640215-001 LED board (includes cable)

640216-001 Plastics Kit (includes the service door)

640217-001 Screw Kit

640218-001 Display Screw Kit

640223-001 43.9 cm (17.3 in), HD, LED, BrightView display assembly in butter gold (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640226-001 43.9 cm (17.3 in), HD, LED, BrightView display assembly in charcoal gray (includes webcam,
two microphones, and wireless antenna transceivers and cables)

640227-001 43.9 cm (17.3 in), HD, LED, BrightView display assembly in pewter (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640926-001 Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter for use only with computer models equipped
with an AMD processor or select models equipped with an Intel processor

641140-001 Heat sink for use only with computer models equipped with an Intel processor, the HM65
chipset, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

641141-001 Heat sink for use only with computer models equipped with an Intel processor, the HM65
chipset, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

641394-001 Power connector cable
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Spare part number Description

641395-001 43.9 cm (17.3 in), HD, LED, BrightView display panel

641396-001 Speaker Kit (includes left and right speakers and cable)

641401-001 Top cover, butter gold (includes TouchPad and TouchPad cable)

641404-001 Top cover, charcoal gray (includes TouchPad and TouchPad cable)

641405-001 Top cover, pewter (includes TouchPad and TouchPad cable)

643698-001 Display hinge covers

644351-001 750 GB, 5400 rpm hard drive 9.5 mm (0.37 in) × 6.35 cm (2.50 in),, SATA, does not include
hard drive connector cable, isolators, or shield)

644685-001 500 GB, 7200 rpm hard drive, 9.5 mm (0.37 in) × 6.35 cm (2.50 in), SATA, does not include
hard drive connector cable, isolators, or shield)

645089-001 320 GB, 7200 rpm hard drive, 7.0 mm (0.28 in) × 6.35 cm (2.50 in), SATA, does not include
hard drive connector cable, isolators, or shield)

649948-001 System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

649949-001 System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with 512 MB of discrete video memory, supports
BACO (includes replacement thermal material)

649950-001 System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with 1024 MB of discrete video memory, supports
BACO (includes replacement thermal material)

649953-001 Heat sink for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

649954-001 Heat sink for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

650198-001 System board for use only with computer models equipped with the Intel HM65 chipset, an
Intel processor, and a graphics subsystem with 512 MB of discrete video memory and supports
BACO, includes replacement thermal material

650199-001 System board for use only with computer models equipped with the Intel HM65 chipset, an
Intel processor, and a graphics subsystem with 1024 MB of discrete video memory and
supports BACO, includes replacement thermal material)

653338-001 Intel Pentium B950 TJ85 2.10 GHz, PGA processor (2.0 MB L3 cache, dual core 35 W; includes
replacement thermal material)

653339-001 Intel Core i3-2330M TJ85, 2.20 GHz, PGA processor (1333 MHz FSB, 3.0 MB L3 cache,
dual core, 35 W; includes replacement thermal material)

653340-001 Intel Core i3-2350M TJ85, 2.30 GHz, PGA processor (1333 MHz FSB, 3.0 MB L3 cache,
dual core, 35 W; includes replacement thermal material)

653341-001 Intel Core i5-2430M 2.40 GHz, PGA processor (turbo up to 3.00 GHz; 1333 MHz, 3.0 MB L3
cache, dual core, 35 W; includes replacement thermal material)

655795-001 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter, for use with
computer models equipped with an AMD processor or select models equipped with an Intel
processor
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Spare part number Description

657325-001 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter, for use with
computer models equipped with an Intel processor or select models equipped with an
AMD processor

659877-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

659878-001 BD ROM DVD±R/RW Super Multi Double-Layer Drive

664662-001 Intel Pentium B960 TJ85 2.20-GHz, PGA, processor (2.0 MB L3 cache, dual core, 35 W;
includes replacement thermal material)

666173-001 Intel Core i7-2640M 2.80 GHz (SC turbo up to 3.50 GHz), PGA processor (4.0 MB L3 cache,
dual core, 35 W; includes replacement thermal material)

669686-001 AMD A4-3320M 2.60 GHz processor (2.0 GHz FSB, 2.0 MB L2 cache, dual core, 35 W;
includes replacement thermal material)

669688-001 AMD A6-3420M 2.40 GHz processor (1.5 GHz FSB, 4.0 MB L2 cache, quad core, 35 W;
includes replacement thermal material)

669690-001 AMD A8-3520M 2.50 GHz processor (1.6 GHz FSB, 4.0 MB L2 cache, quad core, 35 W;
includes replacement thermal material)

672093-001 AMD A4-3305M 2.50 GHz processor (1.9 GHz FSB, 2.0 MB L2 cache, quad core, 35 W;
includes replacement thermal material)

676359-001 Intel Core i5-2450M 2.50 GHz (SC turbo up to 3.10 GHz), PGA processor (3.0 MB L3 cache,
dual core, 35 W); includes replacement thermal material)

676785-001 Intel Pentium B970 TJ85 2.30 GHz, PGA, processor (2.0 MB cache, dual core 35 W); includes
replacement thermal material)

677152-001 Intel Core i3-2370M TJ85 2.40 GHz, PGA processor (3.0 MB L3 cache, dual core, 35 W);
includes replacement thermal material)

677628-001 AMD E2-3000M 2.40 GHz processor (1.8 GHz FSB, 1.0 MB L2 cache, dual core, 35 W;
includes replacement thermal material)

682589-001 160 GB SSD, 6.35 cm (2.50 in)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in
the maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through
the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

the following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.
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Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This section provides removal and replacement procedures.

There are as many as 51 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item Description Function

(1) Product name This is the model name for this computer.

(2) Serial number This is an alphanumeric identifier that is unique to
each product.

(3) Product number This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.
The product number helps a service technician
determine what components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model number This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Feet Kit,
spare part number 639455-001. There are 4 rubber feet that attach to the base enclosure in
the locations illustrated below.

Battery

Description Spare part number

6-cell, 55 Whr, 2.55 Ah Li-ion battery, for use with select computer models only 593554-001

6-cell, 47 Whr, 2.20 Ah Li-ion battery 593553-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Slide the battery release latch (1) to release the battery.

2. Pivot the front edge of the battery (2) up and back.
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3. Remove the battery (3) from the computer.

To insert the battery:

1. Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery
bay.

2. Pivot the front edge of the battery down into the battery bay until it is seated. (The battery
release latch will automatically lock into place.)
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Optical drive

NOTE: The optical drive spare part kit includes a bezel and bracket.

Description Spare part number

BD ROM DVD±R/RW Super Multi Double-Layer Drive 659878-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 659877-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the optical drive:

1. Loosen the two captive screws (1) that secure the service door to the computer.

2. Lift the rear edge of the service door (2) up and forward until it rests at an angle.

3. Remove the service door. The service door is available in the Plastics Kit, spare part number
640216-001.

4. Remove the Phillips M2.5×4.0 screw (1) that secures the optical drive to the computer.
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5. Remove the optical drive (2) by sliding it out of the optical drive bay.

6. If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

7. Remove the two Phillips M2.0×3.0 screws (1) that secure the bracket to the optical drive.

8. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Hard drive or SSD

NOTE: The hard drive spare part kit does not include the hard drive connector cable, isolators, or
shield. The hard drive connector cable, isolators, and shield are included in the Hard Drive Hardware
Kit, spare part number 639444-001. The hard drive connector cable is included in the Cable Kit, spare
part number 640206-001.

Description Spare part number

For use with all computer models:

750 GB, 5400 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in), 644351-001

640 GB, 5400 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 637312-001

500 GB, 7200 rpm, 9.5 mm (0.37 in) × 6.35 cm (2.50 in) 644685-001

320 GB, 7200 rpm, 7.0 mm (0.28 in) × 6.35 cm (2.50 in) 645089-001

160 GB SSD, 6.35 cm (2.50 in) 682589-001

Before removing the hard drive or SSD, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the service door (see Optical drive on page 39).

Remove the hard drive or SSD:

1. Disconnect the drive connector cable (1) from the system board.

2. Lift the front edge of the drive (2) until it rests at an angle.
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3. Remove the drive.

4. Remove the drive connector cable (1) and the drive isolators (2). If it is necessary to replace the
components, the drive connector cable is included in the Cable Kit, spare part number
640206-001. The drive isolators are included in the Hard Drive Hardware Kit, spare part number
639444-001.

5. Remove the drive shield (3). If is necessary to replace the drive shield, it is included in the Hard
Drive Hardware Kit, spare part number 639444-001

Reverse this procedure to reassemble and install the mass storage device.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 637193-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the service door (see Optical drive on page 39).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Slide the RTC battery (2) out from under the surface of the base enclosure.

3. Remove the RTC battery (3) from the system board. (The RTC battery is attached to the system
board with double-sided tape.)

Reverse this procedure to install the RTC battery.
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Memory module

Description Spare part number

4 GB (DDR3, 10600, 1333 MHz) 621569-001

2 GB (DDR3, 10600, 1333 MHz) 621565-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the service door (see Optical drive on page 39).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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WLAN module

Description Spare part number

Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter, for use with
computer models equipped with an AMD processor or select models equipped with an
Intel processor

655795-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter, for use with
computer models equipped with an Intel processor or select models equipped with an
AMD processor

657325-001

Intel Centrino Advanced-N 6230, for use only with computer models equipped with an Intel
processor

631956-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter, for use with computer models equipped with an
Intel processor or select models equipped with an AMD processor

630703-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter, for use with computer models equipped with
an AMD processor or select models equipped with an Intel processor

640926-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the service door (see Optical drive on page 39).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The 1/black WLAN antenna cable is connected to the WLAN module 1/Main terminal.
The 2/gray WLAN antenna cable is connected to the WLAN module 2/Aux terminal.

2. Remove the Phillips M2.5×5.0 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up (3).)
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3. Remove the WLAN module by pulling the module away from the slot at an angle (4).

NOTE: The WLAN module is designed with a notch (5) to prevent incorrect installation into
the WLAN module socket.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module,
the protective sleeves must be installed on the antenna connectors, as shown in the following
illustration.

Reverse this procedure to install the WLAN module.
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Keyboard

NOTE: The keyboard spare part kit includes a keyboard cable.

NOTE: For the complete list of available keyboards, see Computer major components on page 17.

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the service door (see Optical drive on page 39).

Remove the keyboard:

1. Remove the Phillips M2.5×7.0 screw that secures the keyboard to the computer.

2. Rest the computer on its left side.

3. Open the computer.
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4. Insert a screw driver or similar thin tool into the keyboard screw hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.

6. Lift the rear edge of the keyboard, and then swing the keyboard up and forward until it rests
upside down on the palm rest.
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7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

NOTE: The top cover spare part kit includes the TouchPad and TouchPad cable.

Description Spare part number

Butter gold 641401-001

Charcoal gray 641404-001

Pewter 641405-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

When replacing the top cover, be sure that the following components are removed from the defective
top cover and installed on the replacement top cover:

● Power button board and cable (see Power button board on page 53)

● TouchPad button board and cable (see TouchPad button board on page 54)

● TouchPad LED board and cable (see TouchPad LED board on page 55)

Remove the top cover:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the 12 Phillips M2.5×7.0 screws that secure the top cover to the computer.
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4. Remove the two Phillips M2.5×7.0 screws (1) in the hard drive bay and the three Phillips
M2.5×5.0 screws (2) in the battery bay that secure the top cover to the computer.

5. Turn the computer right-side up, with the front toward you.

6. Open the computer.

7. Release the ZIF connectors to which the following cables are attached, and then disconnect
the cables from the system board:

● Power button board cable (1) (included with the power button board spare part kit, spare
part number 640212-001)

● TouchPad cable (2) (included in the Cable Kit, spare part number 640206-001)

● TouchPad button board cable (3) (included with the TouchPad button board spare part kit,
spare part number 640214-001)

8. Remove the Phillips M2.5×5.0 screw (1) that secures the top cover to the computer.
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9. Lift the rear edge of the top cover (2) until the left and right sides disengage from
the base enclosure.

10. Remove the top cover (3).

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board (includes cable) 640212-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the power button board:

1. Turn the top cover upside down, with the front toward you.

2. Release the power button board cable from the clip (1) built into the top cover.

3. Remove the Phillips M2.5×3.0 screw (2) that secures the power button board to the top cover.

4. Lift the right side of the power button board (3) until it rests at an angle.

5. Remove the power button board and cable by sliding the board up and to the right at an
angle (4).

Reverse this procedure to install the power button board and cable.
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TouchPad button board

Description Spare part number

TouchPad button board (includes cable) 640214-001

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the TouchPad button board and cable:

1. Turn the top cover upside down, with the front toward you.

2. Release the TouchPad board cable (1) and the TouchPad button board cable (2) from
the clips (3) built into the top cover.

3. Release the ZIF connector to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (4) from the TouchPad button board.

4. Remove the Phillips M2.5×3.0 screw (5) that secures the TouchPad button board to
the top cover.
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5. Lift the rear edge of the TouchPad button board (6) until it is released from the clips built into
the top cover.

6. Remove the TouchPad button board and cable.

Reverse this procedure to install the TouchPad button board and cable.

TouchPad LED board

Description Spare part number

TouchPad LED board (includes cable) 640213-001

Before removing the TouchPad LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the TouchPad LED board and cable:

1. Turn the top cover upside down, with the front toward you.

2. Release the ZIF connector (1) to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (2) from the TouchPad button board.

3. Release the TouchPad LED board cable from the clip (3) built into the top cover.
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4. Detach the TouchPad LED board (4) from the top cover. (The TouchPad LED board is attached
to the top cover with double-sided tape.)

5. Remove the TouchPad LED board and cable.

Reverse this procedure to install the TouchPad LED board and cable.
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Speakers

Description Spare part number

Speaker Kit (includes left and right speakers and cable) 641396-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the TouchPad LED board and cable:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the speakers (2).

Reverse this procedure to install the speakers.
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LED board

Description Spare part number

LED board 640215-001

Before removing the LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the LED board:

1. Release the ZIF connector (1) to which the LED board cable is connected, and then disconnect
the LED board cable (2) from the system board.

2. Release the clips (3) built into the base enclosure that secure the LED board.

3. Lift the right edge of the LED board (4) to release it from clips built into the base enclosure.

4. Remove the LED board and cable by sliding the board (5) up and to the right at an angle.

Reverse this procedure to install the LED board and cable.
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USB board

Description Spare part number

USB board (includes cable) 640211-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the USB board:

1. Release the ZIF connector (1) to which the USB board cable is connected, and then disconnect
the USB board cable (2) from the system board.

2. Release the clip (3) built into the base enclosure that secures the USB board to the base
enclosure.

3. Remove the USB board (4) and cable.
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Reverse this procedure to install the USB board.

Power connector cable

Description Spare part number

Power connector cable 641394-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

● USB board (see USB board on page 59)

Remove the power connector cable:

1. Disconnect the power connector cable (1) from the system board.

2. Release the power connector cable (2) from the clips (3) built into the base enclosure.

3. Remove the power connector (4) from the clip (5) built into the base enclosure.

Reverse this procedure to install the power connector cable.
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System board

NOTE: The system board spare part kit includes replacement thermal material. Replacement
thermal material is also available in the Thermal Material Kit, spare part number 634433-001.

Description Spare part number

AMD processor:

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with 1024 MB of discrete video memory, supports BACO

649950-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with 512 MB of discrete video memory, supports BACO

649949-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with UMA video memory

649948-001

Intel processor:

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024 MB of discrete video memory, BACO

650199-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 512 MB of discrete video memory, supports BACO

650198-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
UMA video memory

636373-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● RTC battery (see RTC battery on page 43)

● WLAN module (see WLAN module on page 45)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● Memory module (see Memory module on page 44)

● Fan and heat sink (see Fan and heat sink on page 65)

● Processor (see Processor on page 72)
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Remove the system board:

1. Disconnect the following cables from the system board:

● LED board cable (1)

● Speaker cable (2)

● Optical drive cable (3)

● Display panel cable (4)

2. Remove the Phillips M2.5×5.0 screw (5) that secures the system board to the base enclosure.

3. Disconnect the power connector cable (1) from the system board.

4. Release the ZIF connector to which the USB board cable is attached, and then disconnect
the USB cable (2) from the system board.
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5. Lift the right side of the system board (1) until it rests at an angle.

6. Remove the system board (2) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.

Optical drive cable

NOTE: The optical drive cable is included in the Cable Kit, spare part number 640206-001.
The optical drive cable includes the optical drive connector.

Before removing the optical drive cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

● System board (see System board on page 61)

Remove the optical drive cable:

1. Release the optical drive cable (1) from the clips (2) built into the base enclosure.
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2. Release the clips (3) built into the base enclosure that secure the optical drive connector, and
then release the connector (4) from the clips.

3. Remove the optical drive connector and cable.

Reverse this procedure to install the optical drive connector and cable.
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Fan and heat sink

NOTE: The fan and heat sink spare part kits include replacement thermal material. Replacement
thermal material is also available in the Thermal Material Kit, spare part number 634433-001.

Description Spare part number

Fan 639460-001

Heat sink:

AMD processor:

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with discrete video memory

649953-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with UMA video memory

649954-001

Intel processor:

For use only with computer models equipped with the HM65 chipset and a graphics subsystem with
discrete video memory

641141-001

For use only with computer models equipped with the HM65 chipset and a graphics subsystem with
UMA video memory

641140-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan and heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● WLAN module (see WLAN module on page 45)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

● System board (see System board on page 61)
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Remove the fan and heat sink:

1. Turn the system board upside down, with the fan toward you.

NOTE: Steps 2 through 5 apply only to computer models equipped with a graphics subsystem
with discrete memory. See steps 6 through 8 for fan and heat sink removal information for
computer models equipped with a graphics subsystem with UMA memory.

2. Disconnect the fan cable (1) from the system board.

3. Loosen the  screws (2) that secure the fan and heat sink to the system board. (Computer models
equipped with an AMD processor have three screws. Computer models equipped with an
Intel processor have four screws.)

4. Remove the three Phillips M2.5×6.0 screws (3) that secure the fan and heat sink to
the system board.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.
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5. Remove the fan and heat sink (4).

NOTE: The following illustration shows the fan and heat sink being removed from a computer
model equipped with an AMD processor and a graphics subsystem with discrete memory.

NOTE: The following illustration shows the fan and heat sink being removed from a computer
model equipped with an Intel processor and a graphics subsystem with discrete memory.

NOTE: Steps 6 through 8 apply only to computer models equipped with a graphics subsystem
with UMA memory. See steps 2 through 5 for fan and heat sink removal information for
computer models equipped with a graphics subsystem with discrete memory.
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6. Disconnect the fan cable (1) from the system board.

7. Loosen the  screws (2) that secure the fan and heat sink to the system board. (Computer models
equipped with an AMD processor have three screws. Computer models equipped with an
Intel processor have four screws.)

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.

8. Remove the fan and heat sink (3).

NOTE: The following illustration shows the fan and heat sink removal process on a computer
model equipped with an AMD processor and a graphics subsystem with UMA memory.

NOTE: The following illustration shows the fan and heat sink removal process on a computer
model equipped with an Intel processor and a graphics subsystem with UMA memory.
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement
thermal material is included with the base enclosure, fan, heat sink, processor, and system
board spare part kits. Replacement thermal material is also available in the Thermal Material Kit,
spare part number 634433-001.

NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an AMD processor and a graphics subsystem with
discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it

NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an AMD processor and a graphics subsystem with UMA
memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it
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NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an Intel processor and a graphics subsystem with
discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it

NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an Intel processor and a graphics subsystem with UMA memory.
Thermal paste is used on the processor (1) and the heat sink section (2) that services it.

9. If it is necessary to replace the fan:

a. Remove the two Phillips M2.0×3.0 screws (1) that secure the fan to the heat sink.

b. Release the two clips (2) that secure the fan to the heat sink.
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c. Remove the fan (3) from the heat sink.

Reverse this procedure to reassemble and install the fan and heat sink.
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Processor

NOTE: The processor spare part kit includes replacement thermal material. Replacement
thermal material is also available in the Thermal Material Kit, spare part number 634433-001.

Description Spare part number

AMD A8-3520M 2.50 GHz processor (1.6 GHz FSB, 4.0 MB L2 cache, quad core, 35 W) 669690-001

AMD A6-3420M 2.40 GHz processor (1.5 GHz FSB, 4.0 MB L2 cache, quad core, 35 W) 669688-001

AMD A4-3320M 2.60 GHz processor (2.0 GHz FSB, 2.0 MB L2 cache, dual core, 35 W) 669686-001

AMD A4-3305M 2.50 GHz processor (1.9 GHz FSB, 2.0 MB L2 cache, dual core, 35 W) 672093-001

AMD E2-3000M 2.40 GHz processor (1.8 GHz FSB, 1.0 MB L2 cache, dual core, 35 W) 677628-001

Intel Core i7-2640M 2.80 GHz (SC turbo up to 3.50 GHz), PGA processor (4.0 MB L3 cache,
dual core, 35 W)

666173-001

Intel Core i5-2540M 2.60 GHz (SC turbo up to 3.30 GHz), PGA processor (3.0 MB L3 cache,
dual core, 35 W)

631255-001

Intel Core i5-2520M 2.50 GHz (SC turbo up to 3.20 GHz), PGA processor (3.0 MB L3 cache,
dual core, 35 W)

631253-001

Intel Core i5-2450M 2.50 GHz (SC turbo up to 3.00 GHz), PGA processor (3.0 MB L3 cache,
dual core, 35 W)

676359-001

Intel Core i5-2430M 2.40 GHz (SC turbo up to 3.00 GHz), PGA processor (3.0 MB L3 cache,
dual core, 35 W)

653341-001

Intel Core i3-2370M TJ85, 2.40 GHz, PGA processor (3.0 MB L3 cache, dual core, 35 W) 677152-001

Intel Core i3-2350M TJ85, 2.30 GHz, PGA processor (3.0 MB L3 cache, dual core, 35 W) 653340-001

Intel Core i3-2330M TJ85, 2.20 GHz, PGA processor (3.0 MB L3 cache, dual core, 35 W) 653339-001

Intel Pentium B970 TJ85 2.30 GHz, PGA processor (2.0 MB L3 cache, dual core, 35 W) 676785-001

Intel Pentium B960 TJ85 2.20 GHz, PGA processor (2.0 MB L3 cache, dual core, 35 W) 664662-001

Intel Pentium B950 TJ85 2.10 GHz, PGA processor (2.0 MB L3 cache, dual core 35 W) 653338-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● WLAN module (see WLAN module on page 45)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)
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● System board (see System board on page 61)

● Fan and heat sink (see Fan and heat sink on page 65)

Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2), until you hear a click.
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2. Lift the processor (3) straight up, and remove it.

NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

NOTE: The following illustration shows the processor removal process on a computer model
equipped with an AMD processor.

NOTE: The following illustration shows the processor removal process on a computer model
equipped with an Intel processor.

Reverse this procedure to install the processor.
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Display assembly

NOTE: The display assembly spare part kit includes webcam, two microphones, and wireless
antenna transceivers and cables).

Description Spare part number

43.9 cm (17.3 in), HD, LED, BrightView display assembly (includes webcam, two microphones, and wireless antenna
transceivers and cables)

Butter gold 640223-001

Charcoal gray 640226-001

Pewter 640227-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37), and then remove the following components:

● Optical drive (see Optical drive on page 39)

● Hard drive (see Hard drive or SSD on page 41)

● WLAN module (see WLAN module on page 45)

● Keyboard (see Keyboard on page 47)

● Top cover (see Top cover on page 50)

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.

2. Release the wireless antenna cables (2) from the clips and the opening in the base enclosure.

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

3. Remove the three Phillips M2.5×6.0 screws (3) that secure the display assembly to
the computer.
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4. Remove the display assembly (4).

5. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the two screw covers (1) and the two Phillips M2.5×6.0 screws (2) that secure
the display bezel to the display assembly. The screw covers are available in the Display
Screw Kit, spare part number 640218-001.

b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.
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c. Remove the display bezel (4). The display bezel is available using spare part number
640204-001.

6. If it is necessary to replace the webcam/microphone module:

a. Detach and release the webcam/microphone module (1) as far as the webcam/microphone
module cable allows. (The webcam/microphone module is attached to the display
enclosure with double-sided tape.)

b. Disconnect the webcam/microphone module (2) from the webcam/microphone module.

c. Remove the webcam/microphone module. The webcam/microphone module is available
using spare part number 637197-001.

7. If it is necessary to replace the hinge covers:

a. Remove the two Phillips M2.5×5.0 (1) screws that secure the hinge covers to
the display enclosure.
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b. Remove the hinge covers (2). The hinge covers are available using spare part number
643698-001.

8. If it is necessary to replace the display panel:

a. Remove the four Phillips M2.5×6.0 screws that secure the display panel to
the display enclosure.

b. Lift the top edge of the display panel, and then swing it up and forward until it rests upside
down in front of the display enclosure.
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c. Release the adhesive strip (1) that secures the display panel cable to the display panel,
and then disconnect the display panel cable (2) from the display panel.

d. Remove the display panel. The display panel is available using spare part number
641395-001.

9. If it is necessary to replace the display hinges:

a. Remove the four Phillips M2.0×3.0 screws (1) that secure the display hinges to
the display panel.
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b. Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 640207-001.

10. If it is necessary to replace the display panel cable:

a. Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.

b. Release the display panel cable from the clips (2) built into the display enclosure.

c. Remove the display panel cable (3). The display panel cable includes the webcam/
microphone module cable and is available in the Display Cable Kit, spare part number
640205-001.

11. If it is necessary to replace the wireless antenna cables and transceivers:

a. Release the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the wireless antenna cables from the clips (2) built into the display enclosure.
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c. Remove the wireless antenna cables and transceivers (3). The wireless antenna cables
and transceivers are available in the Antenna Kit, spare part number 640192-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility
Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup
Utility includes settings for the types of peripherals installed, the startup sequence of the computer,
and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer
from operating properly.

Starting Setup Utility

NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only
if USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

Changing the language of Setup Utility

1. Start Setup Utility.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of
the screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Setup Utility.

2. Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

● To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information

1. Start Setup Utility.

2. Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility

● To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Setup Utility.

1. Start Setup Utility.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using
the AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During
the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator
before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after
the download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.
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4. Double-click the file that has an .exe extension (for example, filename.exe).

the BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete
the downloaded file from your hard drive.

Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that
the start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact
HP support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.

To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Depth 26.8 cm 10.6 in

Width 41.2 cm 16.2 in

Height 3.1 to 3.7 cm 1.2 to 1.5 in

Weight 2.97 kg 6.55 lb

Input power

Operating voltage 18.5 V dc @ 3.5 A -65 W or 19.0 V dc @ 4.74 A -90 W

Operating current 3.5 or 4.74 A

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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43.9 cm (17.3 in) display specifications

 Metric U.S.

Dimensions

Height 21.7 cm 8.54 in

Width 38.4 cm 15.12 in

Diagonal 43.9 cm 17.29 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 cd/m2 (typical)

Pixel resolution

Pitch 0.197 mm × 0.197 mm

Format 1600 × 900

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption (varies by display) 2.0 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 750 GB* 640 GB* 500 GB* 320 GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm and 7.0
mm

Length 100.2 mm 100.2 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 98 g 110 g 110 g

Interface type SATA (3 GB/sec) SATA (3 GB/sec) SATA SATA

Transfer rate

Synchronous (maximum) 97 MB/sec 106 MB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 1.5 ms 1.5 ms 1.5 ms

Average (read/write) 12/16 ms 12/13 ms 11/13 ms 11/13 ms

Maximum 21 ms 24 ms 22 ms 22 ms

Logical blocks 1,465,149,168 1,250,263,728 976,773,168 628,142,448

Disk rotational speed 5400 rpm 5400 rpm 7200 and 5400
rpm

7200 and 5400
rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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SSD specifications

 

Performance  

Sequential read (maximum) 270 MB/s

Sequential write (maximum) 165 MB/s

Characteristics  

Interface SATA revision 2.6

Flash type Multi-Level Cell (MLC) NAND

Flash capacity 160 GB

Features ATA Security; ATA8-ACS; SATA 2.6; Device Initiated Power
Management (DIPM)

Environmental specifications  

Operating temperature 0°C to +70°C (32°F to 158°F)

Storage temperature -55°C to +95°C (-67°F to 203°F)

Shock 1500 g

Vibration (operating) 2.17 GRMS (5-700 Hz) Max

Physical specifications  

Connector 7+15 pin SATA connector

Weight < 88 g (3.1 oz)
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DVD±RW and CD-RW SuperMulti Double-Layer Combo
Drive specifications

Applicable disc  

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM

Write CD-R and CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time  

DVD < 230 ms

CD < 175 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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BD ROM and DVD±R/RW SuperMulti Double-Layer Drive
specifications

Applicable disc  

Read BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2,
form 1 and form 2), Photo CD (single and multiple sessions), CD Extra,
CD-R, CD-RW, and CD-TEXT

Write DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time  

BD < 230 ms

DVD < 180 ms

CD < 180 ms

Cache buffer 4.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

4X BD 18,000 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode
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7 Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed.

This chapter provides information on the following topics:

● Creating a set of recovery discs or a recovery flash drive (Recovery Manager software feature)

● Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

● Backing up your information

● Recovering a program or driver

Restore
In the event of hard drive failure, to restore your system to its factory image you will need a set of
recovery discs or a recovery flash drive that you can create using HP Recovery Manager. HP
recommends that you use this software to create either a set of recovery discs or a recovery flash
drive immediately after software setup, because you cannot create recovery media after a hard drive
failure.

If for some other reason you need to restore your system, this can be achieved using the HP
Recovery partition, without the need for recovery discs or a recovery flash drive, provided the hard
drive is still working. To check for the presence of a recovery partition, click Start, right-click
Computer, click Manage, and then click Disk Management. If the recovery partition is present, a
Recovery drive is listed in the window.

CAUTION: HP Recovery Manager (partition, or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.
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Creating restore media
HP recommends that you create either a set of recovery discs or a recovery flash drive to be sure that
you can restore your computer to its original factory state if the hard drive fails, or if for any reason
you cannot restore using the recovery partition tools. Create these discs or the flash drive after setting
up the computer for the first time.

NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery
flash drive. Handle these discs or flash drive carefully and keep them in a safe place.

NOTE: If your computer does not include an integrated optical drive, you can use an optional
external optical drive (purchased separately) to create recovery discs, or you can purchase recovery
discs for your computer from the HP Web site. If you use an external optical drive, it must be
connected directly to a USB port on the computer, not to a USB port on an external device, such as a
USB hub.

Guidelines:

● Purchase high-quality DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs.

NOTE: Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE
(rewritable Blu-ray discs), are not compatible with the Recovery Manager software.

● the computer must be connected to AC power during this process.

● Only one set of recovery discs or one recovery flash drive can be created per computer.

NOTE: If you are creating recovery discs, number each disc before inserting into the optical
drive.

● If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open Recovery Manager, you will be prompted to
continue the backup creation process.

To create a set of recovery discs or a recovery flash drive:

1. Select Start > All Programs > Recovery Manager > Recovery Media Creation.

2. Follow the on-screen instructions.
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Performing a system restore
Recovery Manager software allows you to repair or restore the computer to its original factory state.
Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition (select models only) on the hard drive.

NOTE: A system restore needs to be performed if the computer hard drive has failed or if all
attempts to correct any functional computer issues fail.

A system restore should be used as a final attempt to correct computer issues. Note the following
when performing a system restore:

● You can restore only the system that you have previously backed up. HP recommends that you
use HP Recovery Manager to create either a set of recovery discs or a recovery flash drive as
soon as you set up the computer.

● Windows has its own built-in repair features, such as System Restore. If you have not already
tried these features, try them before using Recovery Manager.

● Recovery Manager restores only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled
from the disc provided by the manufacturer.

Restoring using the dedicated recovery partition (select models only)

When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.

To restore the computer from the recovery partition, follow these steps:

1. Access Recovery Manager in either of the following ways:

● Select Start > All Programs > Recovery Manager > Recovery Manager.

– or –

● Turn on or restart the computer, and then press esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen. Then, press f11 while
the “F11 (System Recovery)” message is displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Restoring using the restore media

1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external
optical drive, and then restart the computer.

– or –

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

NOTE: If the computer does not automatically restart in the Recovery Manager, the computer
boot order needs to be changed.

3. Press f9 at system bootup.

4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:

1. Insert the flash drive into a USB port.

2. Restart the computer.

3. Press esc while the computer is restarting, and then press f9 for boot options.

4. Select the flash drive from the boot options window.

96 Chapter 7   Backup and recovery

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Backing up and recovering your information
It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.

How completely you are able to recover your system depends on how recent your backup is.

NOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted.

You can back up your information to an optional external hard drive, a network drive, or discs. Back
up your system at the following times:

● At regularly scheduled times

TIP: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Guidelines:

● Create system restore points using the Windows System Restore feature, and periodically copy
them to an optical disc or an external hard drive. For more information on using system restore
points, refer to Using Windows system restore points.

● Store personal files in the Documents library and back up this folder periodically.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste. The screen image is added to
the document.

4. Save and print the document.
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Using Windows Backup and Restore

Guidelines:

● Be sure that the computer is connected to AC power before you start the backup process.

● Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Using Windows system restore points

A system restore point allows you to save and name a snapshot of your hard drive at a specific point
in time. You can then recover back to that point if you want to reverse subsequent changes.

NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created
since the last restore point.

You also can create additional restore points to provide increased protection for your files and
settings.

When to create restore points

● Before you add or modify software or hardware

● Periodically, whenever the computer is functioning optimally

NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click System Restore.

5. Follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 V ac, or from 220 to 240 V ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country and
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

100 Chapter 8   Power cord set requirements

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1

Japan JIS 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea KTL 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom ASTA 1
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Country/region Accredited agency Applicable note number

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75 mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL
mark. UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² or 1.25 mm² conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3-conductor, 0.75 mm² conductor size. KTL logo and individual approval
number must be on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3-conductor, 1.25 mm² conductor size. Power cord set fittings (appliance
coupler, cable, and wall plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3-conductor, 18 AWG, with plug NEMA 5-15P (15 A, 125 V
ac), with UL and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3-conductor, 0.75 mm² or
1.00 mm2 conductor size, with plug BS 1363/A with BSI or ASTA marks.
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9 Recycling

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for battery disposal. HP
encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For more information about recycling programs, see the HP website at www.hp.com/recycle.
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illustrated 22

TouchPad components 11
TouchPad LED board

removal 55
spare part number 19, 28, 55

TouchPad light 10, 11
TouchPad on/off button 11
TouchPad zone 11
transporting guidelines 34

U
USB board

removal 59
spare part number 19, 28

USB port 13, 14

V
vents 13, 15
video, product description 4

W
webcam 12
webcam light 12
webcam/microphone module

removal 77
spare part number 23, 27, 77

Windows applications key 9
Windows logo key 9
wireless antenna

locations 12
removal 80
spare part number 23, 27, 81

wireless light 10
wireless, product description 5
WLAN module

removal 45
spare part numbers 21, 27,

28, 29, 30, 45
workstation guidelines 34
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